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1. Introduction 

 

 

Recognizing that Adobe Lightroom became a popular, general use, image workflow software 

program for professional and advanced amateur photographers, DxO Labs is making 

significant efforts to set up bridges and links between DxO Optics Pro and Lightroom. 

 

As a result of these efforts, DxO Optics Pro v4.5 was the first major photographic software 

application to start building a common workflow with Adobe Lightroom. We have long been 

pioneers in establishing compatibility with Adobe technologies, and this is no exception. We 

see Adobe Lightroom as an important platform for photographers, and our goal will be to 

enrich that platform and provide better value to you – the photographer. 

As with all pioneering efforts, we know that we are just at the beginning of this adventure. 

And “Yes”, there are still things that will have to be worked on until we reach a fully 

integrated experience. We hope you will join with us on this journey and take the time to 

provide us your feedback, your questions, and your suggestions. That is how we will all 

move forward together. 

This document refers to DxO Optics Pro 6.3 and above (Standard and Elite versions), and to 

Adobe Lightroom v2 and v3. 

 

Determining your best workflow scenario depends on many factors, such as the number of 

images you want to process, whether you will want to make selections from your images 

prior to doing any processing or process all of the images you have, how much time you 

have available for your post-production work, the speed of your computer system (also time 

related), and the results you want for your images. 

 

The following sections of this document are not designed to provide you with all possible 

answers, but instead give you ideas that will help you tailor a unique, post-production 

workflow that is right for you. 

 

Digital photography brings a unique opportunity to all modern photographers. With traditional 

film photography, we were limited to controlling the picture taking process. Unless we had 

the time, money, equipment, and skills, our post-production capabilities were limited to 

taking our rolls of film to a local developer or lab. There, we could only tell the developer 

what we wanted, and our ability to interact in the image-output process was both time 

consuming and restricted. 
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But with today‟s ever improving digital cameras, computers, printers, and software, we now 

have the opportunity to control the entire photographic process, end-to-end. Never have 

photographers had such total control over all aspects of the photographic process as they do 

today. 

 

However, with this control comes a greater degree of complexity. Most of us can easily 

point-and-shoot and store an image on our camera cards or discs. But, what comes next? 

Here is where a good post-production workflow can be extremely effective in allowing us to 

achieve the results we want for our images in the least amount of time. 

 

The following sections will continually strive to help provide you with these answers. Is there 

one workflow that is better than another? “Yes.” What is it? It is the workflow that meets your 

specific needs. 

 

In some cases, the connection between Adobe Lightroom and DxO Optics Pro may not 

behave exactly as you would expect. This is because in order to provide a tight level of 

integration between the products, we have had to use some Lightroom functions in a way in 

which they were not initially designed to be used. As Adobe Lightroom matures, and in 

particular if an official third-party development interface is provided by Adobe, we will be able 

to build on those foundations and provide even better integration in the future. 

 

For optimal success, we recommend that you take time to carefully read the instructions 

associated with each section of this document. 
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2. DxO Optics Pro overview 

 

 

DxO Optics Pro is one of the best photo correction and adjustment programs on the market 

today. 

 

Unlike most software available to photographers, DxO Optics Pro takes an entirely different 

approach to image correction by proactively addressing the optical problems that exist in all 

digital cameras and lenses. 

DxO Optics Pro provides unique capabilities to automatically correct and enhance images 

from digital cameras. In particular, DxO Optics Pro relies on extensive measurements and 

calibration of supported cameras and lenses to be able to provide superior results with no, or 

minimal, user intervention. 

 

Automatic correction of distortion is a good example of DxO Optics Pro‟s capabilities. 

Thanks to our calibration process, DxO Optics Pro can automatically correct a set of images 

each exhibiting different distortion problems (for example taken at various focal lengths or 

with different lenses). There is no need to manually adjust each image, and the software will 

just as easily correct a very complicated distortion as a simple one. 

Additional corrections applied by DxO Optics Pro are lens softness, chromatic aberration, 

vignetting, volume anamorphosis correction, and keystoning. DxO Optics Pro can also do 

many other things to help improve the quality of your images. Please check out 

www.dxo.com for a full list of DxO Optics Pro‟s capabilities.  

  

http://www.dxo.com/
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3. Adobe Lightroom overview 

 

 

In early January, 2006, Adobe announced a new software program designed specifically for 

digital photographers, Adobe Lightroom. Lightroom is primarily targeted for photographers 

who have a large number of images to process, or they have complicated image adjustment 

requirements and need to effectively control their overall post-production processes. 

Both Lightroom and Photoshop are image manipulation tools. But where Photoshop is a 

„one-stop‟ application for many imaging enhancement needs, this power comes at a cost. 

Many people find Photoshop difficult to learn and use effectively. Enter Lightroom, which 

Adobe has built from the ground up to be the application that binds the key steps of a good 

post-production workflow together. Not only do you have light table and advanced archival 

capabilities, but you can call your favorite photo editing programs from within Lightroom 

itself. Besides many new features, Lightroom 2.0 and subsequent versions allow you to use 

as many external editors as you wish, as opposed to Lightroom 1.x‟s limitation of 2 external 

editors (one selection being reserved for Photoshop or Photoshop Elements). 

 

At DxO Labs, we acknowledge Adobe Lightroom as an important “platform application” for 

photographers. And, we recognize Lightroom‟s ability to provide many core services and 

tools to photographers. We also envision this platform fostering the development of a vibrant 

and dynamic post-production ecosystem of other applications that will provide extraordinary 

functionality and benefits. That is how we see DxO Optics Pro contributing to the success of 

photographers who decide to use Adobe Lightroom in their workflow. 

So, it is clearly evident that both DxO Optics Pro and Adobe Lightroom are complementary. 

Adobe Lightroom provides the ability to better organize and output your images, and DxO 

Optics Pro provides the advanced corrections and adjustments that have made it an industry 

leader in post-production work and productivity. 

The following sections will explain how these two outstanding programs can work together 

for your benefit.  

 

Important Note: 

The screenshots in this document have been made with Lightroom 2.5.  
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4. DxO Optics Pro & Adobe Lightroom Workflow 

 

Three workflow scenarios will be considered in this document. 

 

Scenario 1: Images are processed by DxO Optics Pro before being imported into Adobe 

Lightroom. Both programs are used in a standalone mode. 

Two possibilities are offered: 

- Scenario 1a: Exporting from DxO Optics Pro to Lightroom. 

- Scenario 1b: Processing pictures in DxO Optics Pro back to the original folder, and 
then synchronizing this folder within Lightroom to import the processed images into 
the Lightroom catalog.  
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Scenario 2: Images are sent to DxO Optics Pro from Adobe Lightroom, and returned to 

Adobe Lightroom after DxO Optics Pro processing is completed. This is the External Editor 

option. 
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Scenario 3: Images in the Adobe Lightroom database are directly accessed by DxO Optics 

Pro 6, corrected by DxO Optics Pro, and saved on the hard drive wherever required. 

 

Note: in case of Lightroom 3, this scenario only works if the catalog that DxO Optics Pro is 

trying to access is not already in use by Lightroom 3. In this case, the catalog would be 

locked by Lightroom 3 and therefore inaccessible from DxO Optics Pro. Earlier versions of 

Lightroom did not have this restriction. 
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 How do you choose between those three scenarios? 

 

Scenario 1: One good reason to choose scenario 1 is if you want to work with an all-RAW 

workflow and use the DNG picture format produced by DxO Optics Pro in Adobe Lightroom. 

(If you choose scenario 2, you cannot use the DNG format after processing your images in 

DxO Optics Pro. Please see the scenario 2 section for more details.) 

Another good reason is if you intend to batch correct large numbers of images with DxO 

Optics Pro. This is especially true if you have mixed RAW and JPEG files. (This is primarily 

due to the current limit of allowable file formats that Adobe Lightroom permits to pass 

between itself and an external editor.) This scenario is also best used when you have a 

limited amount of time to process your images because of the improvement in processing 

speed when using Optics Pro in standalone mode. 

 

Scenario 2: This scenario is best suited for the individual or the batch processing of smaller 

numbers of images. In this scenario, you have the opportunity to give your images greater 

attention to detail, specifically targeting particular problems or effects to improve each image. 

This scenario may take a bit more time overall, but it can deliver outstanding results.  

 

Scenario 3: This scenario allows you to directly access Adobe Lightroom‟s database from 

within DxO Optics Pro. 

 

Now let‟s explore each solution in detail. 
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4.1 Scenario 1 – Using DxO Optics Pro and Adobe Lightroom as standalone 

programs 

 

 

 

 

 

4.1.1 Setting up DxO Optics Pro 

No specific settings are required to optimally use DxO Optics Pro in this scenario. Use the 

settings that work best for you. 

 

4.1.2 Setting up Adobe Lightroom 

No specific settings are required to optimally use Adobe Lightroom in this scenario. Use the 

settings that work best for you. 
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4.1.3 Processing an image batch 

 

 Step 1: Open and process images with DxO Optics Pro 

 

 Open images in DxO Optics Pro 

 

Go to the folder where your images are kept. 

In the Select tab, choose the images you want to process and click the „Add to Project‟ 

button (red arrow above). Thumbnails will appear in the lower project window. You can also 

drag the thumbnails into the lower window. 
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 Adjust settings in DxO Optics Pro 

 

Adjustments to DxO Settings can be made in the Customize tab screen. The key to making 

your adjustments to DxO settings is in the different corrections Palettes, which can be found 

on both sides of your screen. 

Hint: Please refer to the DxO Optics Pro user manual for more information about DxO 

Optics Pro adjustments. 

 

 Adjust output settings in DxO Optics Pro 

Once your adjustments have been completed, in the “Process” tab select where you want 

your corrected images to be saved, and in which format (JPEG, TIFF or DNG).  

Hint: Please refer to the DxO Optics Pro user manual for more information about using DxO 

Optics Pro output settings). 

Corrections 

Palettes 
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Start processing by clicking on the “Start” button.  

  

Start button 
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 Step 2a: Exporting images to Adobe Lightroom 

 

 

Once processing is complete, your images can be exported directly to Adobe Lightroom from 

within DxO Optics Pro. To do this, simply click on the “View” tab and select the images you 

want sent to Lightroom in the lower project window. Click on the Adobe Lightroom icon 

(“LR”) in the bar just above the project window. 
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The first time you invoke Lightroom, you will need to locate the Adobe Lightroom application 

in the Program File of your computer, as shown in the screenshot above. HINT: Use the blue 

finder button to the right of the folder path field. You do not need to do this task the next time 

you send processed pictures to Lightroom. DxO Optics Pro will „remember‟ Lightroom‟s 

location on your computer. 

 

When Lightroom has been located, make sure that the Export format has been selected and 

click on Next, as shown in the screenshot above. 

 

While adjusting the output settings in the Process tab, you can choose any destination 

folder, including the same folder as the original image. 
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When the processed images have been exported from DxO Optics Pro, Lightroom‟s Import 

menu will open automatically. 

Important Note: 

If you are reprocessing original images in DxO Optics Pro and the output images from the 
last processing run are already in the Lightroom database, you must remove the older DxO 
Optics Pro pictures from Lightroom before clicking on „Export‟. If you do not remove these 
images first, you will get an error message from Lightroom, and your new images will not be 
exported to Lightroom. 

Set the import settings you want to apply to your images. These settings are normal 

Lightroom settings that would be used for any image imported into the program. Note that if 

you want to set up for the importation of metadata to Lightroom, you may do so now and 

have it applied to your imported images. 

Click on the „Import‟ button. Your DxO Optics Pro processed images will be placed into the 

Adobe Lightroom database and displayed in the Adobe Lightroom window. Images can now 

be further processed in Adobe Lightroom, if necessary. 

  

Metadata 
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 Step 2b: Export images to the original folder and synchronize it within Adobe 

Lightroom 

Since version 1.1, Lightroom has been able to synchronize folders. It can add new files, 

detect and remove deleted files, and scan metadata for updates. The following steps explain 

how to use this function to manually import pictures edited by DxO Optics Pro. 

 

In the output settings of the Process tab of DxO Optics Pro, make sure that the destination 

folder is the same location where the original pictures are stored. You can rename the 

exported files with a suffix – like “DxO” in order to distinguish them in your image catalog. 

NOTE: Do not forget to save the changes in the output settings or they will not be applied to 

the output files when processing is completed. 

 

When DxO Optics Pro has completed processing your pictures, go back to the Folders panel 

in Lightroom‟s Library module. Right click on the original file folder and select “Synchronize 

Folder” in the contextual menu. 
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A dialog box will pop-up with the following selectable items: 

- Import new photos: This includes the pictures added by DxO Optics Pro in the folder. 

- Show import dialog before importing: Unless you want to apply metadata or develop 
presets, please unchecked this box in order to skip this step. 

- Remove missing photos from catalog: This option should be grayed out in our case. 

- Scan for metadata updates: Check this box to let Lightroom analyze the metadata 
changes. 

 

Click on the “Synchronize” button. All pictures previously processed by DxO Optics Pro will 

be imported and will show up in Lightroom‟s catalog. If “Show import dialog before importing” 

was selected, the Import menu will be displayed (screenshot above). The picture below 

shows the file renamed in accordance with your output settings in DxO Optics Pro. 
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4.2 Scenario 2 – Using the External Editor function in Lightroom 

 

 

 

 

4.2.1 Setting up Adobe Lightroom 

Lightroom 2.0, and subsequent versions, give you the ability to add and use more than one 

external editor in Lightroom 
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Open the Preferences and the External Editing tab. 

Click on the "Choose" button in the Additional External Editor field.  

- On a Windows computer, select "DxOOpticsPro6 " as the Additional External Editor 
(this file can usually be found in C:\Program Files\DxO Labs\DxO Optics Pro v6. 

 

 File format: Choose the “TIFF” file format. Note: If you choose “PSD”, images cannot 
be edited in DxO Optics Pro. (“PSD” is a file format supported by Adobe Photoshop 
and not by DxO Optics Pro). The limitation of supported file formats to TIFF and PSD 
are controlled by Lightroom. 

 Color space: Note that whatever option is chosen, DxO Optics Pro will return an 
image with the same color profile as the input image. 

 Bit depth option: Whatever option is chosen:  

- If working on a RAW image, DxO Optics Pro will always return a 16-bit image. 

 Compression: Whatever option is chosen, DxO Optics Pro will return uncompressed 
images for TIFF.  

 In the Additional External Editor field, scroll the Preset menu and choose „Save 
current settings as new preset‟.  

 Enter a new preset / external editor name (i.e. DxO Optics Pro 6) and click on Create. 
The external editor is now ready to use and there is no need to restart Lightroom.  

Note: in the case of RAW image and when working with Lightoom 3, it is required that: 

 The naming of files sent to the external editor is the default scheme « ImageName-

Edit.tiff », or any other scheme like « ImageName-xxxx.tiff ». This renaming scheme 

can be set at the bottom of the dialog window of the external editor preferences. In 

case it does not follow this pattern it can be reset by typing the following string: 

{Filename »}-Edit 

 Please also note that the original image name does not contain “-“ 
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In case these requirements are not followed, DxO Optics Pro will not find the RAW image 

and will therefore not be able to perform the RAW conversion, noise removal and optical 

corrections. 

 

4.2.2 Setting up DxO Optics Pro 

It is recommended to activate the “Preserve XMP data for RAW image” option in DxO Optics 

Pro preferences (in the preferences processing tab). This option is enabled by default. It 

ensures that metadata entered in Lightroom on RAW images will be read by DxO Optics Pro 

and incorporated (and therefore maintained) in images sent back to Lightroom.  

Note: Preferences can only be accessed in the standalone version of DxO Optics Pro. They 

cannot be accessed in the “Lightroom External editor” version. 

 

4.2.3 Processing an image batch 

Important Note: 

Please make sure that DxO Optics Pro is not already running. If it is, please close it. 

Otherwise Lightroom will be unable to send images to DxO Optics Pro. Only one instance of 

DxO Optics Pro can be running on your system at a time. 

 How to send images from Adobe Lightroom to DxO Optics Pro? 

There are several ways to send images from Lightroom to DxO Optics Pro. 

- Do a right-click on any thumbnail, selection of thumbnails, or an image in Loupe 

mode (full size display), and select Edit in > Edit in DxO Optics Pro 6 in the 

contextual menu. (The name of the external editor was set when you configured the 

Lightroom preference to use the editor.) 
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- Another less convenient way is to start from the upper Photo menu and select Edit in 

... > Edit in Optics Pro 6 in the contextual menu. 

 

 

 Recommended workflow for RAW images 

Important Note: 

Depending upon which version of Adobe Lightroom you are using, the options noted below 

may be displayed in a different order. 
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As you can see in the image above, the “Edit Original” and “Edit a Copy” options are grayed 

out and therefore not available. Only “Edit a Copy with Lightroom Adjustments” can be 

selected. 

 

Important Note: 

Although this “Edit a Copy with Lightroom Adjustments” option says that the image will be 

sent to DxO Optics Pro with Lightroom Adjustments, this is not the case. It is, in fact, the 

original RAW image that is sent to DxO Optics Pro and any Lightroom adjustments you may 

have made before sending the image to DxO Optics Pro will be ignored by DxO Optics Pro. 

In case you want to make adjustments in Lightroom, the recommended workflow is to start 

from Lightroom, edit your images in DxO Optics Pro, and then perform any adjustments you 

want to make in Lightroom after DxO Optics Pro processing has been completed. 

Two other workflows are available though: 

1) You can choose Scenario 1 described at the beginning of this document, or 

2) In case you want to use scenario 2, and you have performed adjustments to your images 

in Adobe Lightroom prior to sending them to DxO Optics Pro, you can copy the Lightroom 

adjustments settings from the “Lightroom adjusted” images and paste them onto the “DxO 

Optics Pro corrected” images. 

Important Note: 

 RAW images edited by DxO Optics Pro will always be returned to Lightroom as 16-bit 
TIFF files. This is a limitation of Adobe Lightroom.  

Hint: You may want to enable the “Stack with original” option to avoid displaying different 

versions of the same image. 

 

 Recommended workflow for  JPEG images 

Important Note: 

Depending upon which version of Adobe Lightroom you are using, the options noted below 

may be displayed in a different order. 
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In this step, you can choose between the following options in Lightroom: 

 

 Edit a Copy with Lightroom Adjustments.  

 Edit a Copy. 

 Edit Original. 

 

Suggested workflow: 

We strongly recommend using options  or  if you want to correct the image without 

adjustments already performed in Lightroom. DxO Optics Pro will then have access to all 

EXIF data required to perform automatic optics corrections. 

All metadata that may have been entered in Lightroom prior to sending the image to DxO 

Optics Pro will be kept when the processed image is returned to Lightroom. This is valid for 

keywords, IPTC fields, and image rating. 

Using option , "Edit a copy with Lightroom adjustments" may lead to unexpected results. 

Hint: You may want to enable the “Stack with original” option to avoid displaying different 

versions of the same image. 

Please refer to the “Setting up Adobe Lightroom/Open the Edit/Preference menu” section 

above for the “Copy File Option”. 
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 Image transfer 

 

 

In case you selected options  or , a new image (image copy) appears (see above) and 

DxO Optics Pro is automatically launched.  

Important Note: 

Make sure that DxO Optics Pro is closed before sending images from Lightroom. You can 

only have one instance of DxO Optics Pro running on your system at a time. 

In the screen shot above, note the duplicate image (highlighted) created by editing the image 

in an external editor (DxO Optics Pro in our case). 

 Receiving images in DxO Optics Pro 

Images are automatically received in DxO Optics Pro in the “Customize” tab. The “Select” 

and “View” tabs are not needed when using DxO Optics Pro as an external editor for Adobe 

Lightroom since you select and view your images in Lightroom. 

Original  images 

Image copies 
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Adjustments can be performed within DxO Optics Pro (refer to the user manual for more 

information about DxO Optics Pro settings and adjustments). 

 

Important Note: 

Adobe Lightroom maintains its own EXIF/IPTC database, but any information entered in DxO 

Optics Pro in the Author or Copyright fields will be recognized and taken into account by 

Adobe Lightroom. They will respectively show up in the Library module > Metadata panel (all 

or IPTC) > Creator and Copyright fields. This statement is valid For RAW, TIFF and JPEG 

files. 

Once adjustments have been made, processing is started by clicking on the “Process” 

button in the “Process tab” (output format and output location are automatically set by DxO 

Optics Pro to ensure a transparent workflow with Lightroom. They cannot be changed). 

Adjustment 

sliders 
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Once images have been processed, DxO Optics Pro automatically overwrites images that 

had been sent by Lightroom with the DxO Optics Pro corrected images and DxO Optics Pro 

closes down automatically (Mac) or after clicking on the “Yes” button in the final dialog box 

(Win). 

Important Note: 

DxO Optics Pro will return images to Lightroom in the same format that it received them from 

Lightroom (in this case TIFF files). 
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 Sending images back in Lightroom 

The corrected images will appear as an update of the images that had originally been sent 

by Adobe Lightroom to DxO Optics Pro. 

 

The screen capture above illustrates the case when option  or  was selected at the “How 

to send an image from Adobe Lightroom to DxO Optics Pro?” stage. 

In either case, corrected images can now be further processed in Adobe Lightroom in 

accordance with the recommendation to edit images in DxO Optics Pro first. 

 

Important Note: 

If option  was selected, the original images in your Lightroom database would have been 

overwritten by DxO Optics Pro, resulting in only one image being displayed instead of a pair 

of images as illustrated above. 

  

Original  images 

Image copies 
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4.3 Scenario 3 – Accessing the Adobe Lightroom database from within DxO Optics 

Pro 

Reminder: When using Lightroom 3, this scenario only works if the catalog that DxO Optics 

Pro is trying to access isn‟t already being used by Lightroom 3. In this case, the catalog will 

be locked by Lightroom and inaccessible from DxO Optics Pro. Earlier versions of Lightroom 

do not exhibit this problem. 

 

 

4.3.1 Setting up DxO Optics Pro 

In case of RAW images, it is recommended that you activate the “Preserve XMP data for 

RAW image” option in DxO Optics Pro preferences (in the preferences processing tab), This 

option is enabled by default. It ensures that metadata entered in Lightroom on RAW images 

will be read by DxO Optics Pro and incorporated (and therefore maintained) in DxO Optics 

Pro output images.  

 

4.3.2 Setting up Adobe Lightroom 

In case of RAW images, if you want metadata entered in Lightroom to be maintained in the 

processed image file after DxO Optics Pro processing is completed, the appropriate option 
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must be selected in Lightroom. This option will generate a corresponding XMP file along with 

each image for which metadata has been entered in Lightroom. DxO Optics Pro will then 

read this data and will include it in its output images. This option can be set as follows in 

Lightroom: 

- go to the Edit>Preference menu 

- in the “General” tab, click on “Go to catalog setting” 

- in the “Metadata” tab, check “Automatically write changes into XMP” 

 

4.3.3 Processing an image batch 

The advantage here is that instead of browsing your hard drive to select images you want to 

process with DxO Optics Pro, you can directly select an Adobe Lightroom database from 

within Optics Pro and browse through it. 

Adobe Lightroom databases can be accessed by clicking the Adobe Lightroom icon (“LR”) 

on the top left corner of the DxO Optics Pro Browse menu as shown in the red rectangle 

below. 

 

You then select your Adobe Lightroom Catalog and browse through your Libraries, folders or 

collections, on the left hand side of the window above. Images can then be selected and 

dropped into the lower project window for DxO Optics Pro processing. 

 

Important Note: 
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- DxO Optics Pro accesses the Lightroom catalog in “read only” mode and will never 
alter any data in the catalog. 

- Any change that may have been performed on the image in Adobe Lightroom will be 
ignored by DxO Optics Pro. 

- Once processed in DxO Optics Pro, images will not be written back into the Adobe 
Lightroom„s database. They will be stored in the folder you have specified in the 
“Process” tab in DxO Optics Pro. 

- To bring the processed pictures into your Lightroom catalog, you will need to apply 
the folder synchronization method previously explained in step 2b. 

 

 

We know that you will enjoy using DxO Optics Pro with Adobe Lightroom and that you will 
find both programs to be invaluable to your post-production workflow. If you have any 
questions or suggestions, please contact us. 


